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Exercise 01 – Introduction 
 
Introduction - Basic Principles of GIS 
GIS is a technology used to view and analyze data from a geographic perspective. 
GIS links location to information, and layers that information to give a better understanding 
of how it interrelates. A GIS map is therefore composed of many layers, or collections of 
geographic objects that are alike. You choose what layers to combine based on your 
purpose. The following map contains four layers, Cities, Rivers, Countries, and 
Topography (elevation data). 
Remember: A Map is made up of Layers 
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In the preceding map, the “Field visit sites” layer is made up of many different visited 
sites, and the “Road” layer of many different road types. The same is true of the 
“Provinces” layer. Each geographic object in a layer, - each field visit sites, road and 
provinces – is called a Feature. 
Remember: Layers contain Features 
 
 
In any GIS software, geographic features are represented as one of three geometrical 
forms, a polygon, a line, or a point. Polygons represent things large enough to have 
boundaries, such as countries, lakes or other large tracts of land. Lines represent 
narrow, linear features, such as roads, rivers or pipelines. Points are used for things too 
small to be represented as polygons, such as cities on a map of the United States, or 
schools on a map of DC. Polygons, lines and points are collectively called Vector Data. 
Remember: Features can take the form of Points, Lines and Polygons, and are known 
collectively as Vector Data. 
 
Not all layers contain Features, the topological (shaded relief) layer you see above is not 
a collection of geographic objects in the same way the other layers are. It is a single 
continuous expanse that changes from one location to another according to the 
height/depth of the Earth’s surface. A geographic expanse of this type is called a Raster. 
We use Rasters because unlike rivers, or countries, things such as elevation, 
temperature, rainfall or wind speed have no distinct shape. 
A Raster is a matrix of identically sized square cells or pixels (much like a digital 
photograph). Each cell represents a unit of surface area, and contains a measured or 
estimated value for that location. When displaying this information, colors are assigned 
to the individual pixel values along a ramp scale. 
 



 4 

Remember: Layers also contain Rasters 

 
 
There is much more to an individual feature than its shape and location, and GIS files 
have the potential to incorporate this additional information. There is a great amount of 
information that may be gathered about any one feature. A country has population, a 
capital, a system of government, leading imports and exports, average rainfall, mineral 
resources and many other things. Roads have grading systems, speed limits, number of 
lanes, and one or two-way systems.  
 
Information about the individual feature of any one layer is stored in a table. The table 
has a record (row) for each feature in the layer, and a field (column) for each category of 
information. These information categories are called attributes; therefore, these tables 
are commonly referred to as “Attribute Tables”. 
Each object (or “feature”) on a GIS map is linked to a row of information in an attribute 
table. 
 
Remember: Layers contain Features, and each Feature is linked to a row of 
information in the Attribute table 
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Now, lets get started making our own map!!! 
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Lab 01 – ArcGIS Basics 
The ArcMap Interface & Adding Data 
 
1. Start ArcMap by double-clicking the ArcMap icon on your computer desktop. 

(Alternately, click the “Start” menu, point to “All Programs”, point to “ArcGIS” and 
select “ArcMap”) 

 

 
 
2. You may receive the following welcome screen, if so, select “a new empty map,” and 

press OK. If you do not receive this screen, ArcMap has selected a blank map by 
default. 

 
 
3. You are now looking at the basic ArcMap screen with its various menus and tools. To 

begin with, we will add some data. From the “File” menu, select “Add Data”. (You will 
notice that the “Add Data” icon is replicated on the main tool bar. You will find that 
this is the case for many of the tools and functions within ArcMap.) 
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4. In the “Connect to folder” window, navigate to the location of your Tutorial folder: 

“C:\Student\GISLab”, and click OK. 
 

5.  You will only have to do this step once. By establishing this connection, you will be 
directed to your GIS lab folder each time you return to it and add new data to the 
map. It’s like creating a shortcut. 

 

 
6. Now open the folder “Lab01”, and select the file named “Province”.  
 
 
(If a warning box pops up when you attempt to add data at any point, just click OK) 
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7. The outline of PNG should now be visible in your map window. Notice that on the left 

hand side of the screen you have a box containing a short list, beginning with the 
word “Layers.” This box is called the Table of Contents, and it lists the names of the 
various data layers in the map. It shows the color symbol used to draw each layer, 
and tells you by means of a check mark, whether or not the layer is visible. 

 
8. Left click on the various (+) & (-) boxes in the Table of Contents window, noticing 

how the Table of Contents changes. It works in a similar way to a data tree within 
Windows Explorer. Click on the checked box next to the “Province” Layer to turn the 
layer off, click it again, and the map reappears. 

 
9. The main window of the ArcMap interface is called the Data Frame. It is where your 

data is displayed and manipulated. The various toolbars can be found both above 
and below the Data Frame. Many of their functions are also replicated in the 
standard drop down menus to the top left. 

 
10. In order to make the map more detailed, we will add further layers. Add additional 

data by using either the “File” menu, or click on the “Add data” icon . You will be 
taken back to the “Lab01” folder. Select “Town.shp” and holding down the “ctrl” key 
select “Rivers.shp”. Click Add. The fact that you now have multiple layers in your 
map is represented in your Table of Contents.  Make sure that you see the 

Tools used to query and zoom data 
frame 

Table of 
Contents 

Data Frame 
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“Provinces”, “Towns”, “Rivers” shapefiles in your Table of Contents on the left of your 
screen. 

 
 

Navigation using the ArcMap Toolbars 
 
11. Hold down your left mouse button over “Towns.shp” and drag it down below your 

“Provinces.shp” file. What happened to your map? The Table of Contents window 
controls the various layers of your map. Whichever layer is on top in the Table of 
Contents, will also be the topmost layer of your map. Move the other layers around to 
see how this property works.  

 
IMPORTANT NOTE: In order to drag files to reorder them, your table of 
contents must be in the List by Drawing Order mode, look at the top of 
the table of contents and make sure that the List by Drawing Order tab 
is selected.  Click on the List by Source tab at the top of the Table of Contents.  Now that 
you are in this tab, you can see where each data source came from.  Try to reorganize 
your shapefiles so “Provinces” is on the top again.  Notice that you cannot move the 
order of your shapefiles unless you are in the List by Drawing Order mode tab.  Click on 
the List by Drawing Order mode tab again at the bottom of your Table of Contents in 
order to change order of your shapefiles in the Table of Contents. 
 
 
12.  On your screen are various tool icons. By moving your mouse over each icon in 

turn, a pop-up box will alert you to the name and/or function of that particular tool. 
Many of the tools, though new, are self-explanatory, and many others, such as the 
“Drawing” tools, are quite similar to those found in basic Windows programs. The 
most basic toolbar within ArcMap contains the navigational tools: 

 

 
 

13.  Locate the “Zoom In” tool . Using this tool, draw a box around Lae city by left 

click and hold while you draw a box. Now, select the tool that looks like a hand . 
This is called the “Pan” tool. Use it to ‘grab’ the map and move it around in order to 
see other areas of your map. 

 

14. On your toolbar, you will see the scale box.  
 

15. Using the “zoom in” / “zoom out”  or the “fixed zoom in” / “fixed zoom out” 

Tools   , adjust the map until your scale shows approximately “1:7,000,000”. 
You may also manipulate the scale box by directly typing the required scale. 

 

16. Switch to the identify tool  and click on any one of the diamonds representing the 
towns. The “Identity Results Dialog” shows you various facts about the feature that 
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you have selected. Using the Identify tool, you 
can see the information associated with each 
town in the pop-up dialog. 

 

17. Now click on the tool called “Full Extent”.  
This resizes your map to cover the full area of 
your largest feature (all of PNG). 

 

18. Click on the tool for “Previous Extent”  
and it will take you back to your last zoomed in 
view. 

 
Now that we have explored a little on how to 
maneuver the basic tools in the map viewer 
format, we will now look at the data that are 
behind the shapefiles, these data are very similar 
to an excel table. 
 

 
Feature Attribute Tables 
In GIS, a feature on a map may be associated with a great deal of information – more 
than can be displayed at any given time. This information is stored in an Attribute 
Table. A data layer’s attribute table contains a row (or record) for every feature in the 
layer and a column (or field) for every attribute, or category of information. When you 
clicked on one of the ‘Town points in Step 16 (above), the information you saw in the 
identify results dialog was the information stored in the Attribute Table for the “Towns” 
Layer. 
 
19. . Click on the “Add data” icon. You will be taken back to the 

“Lab01” subfolder. Select Districts.shp” and click “Add”. You 
may have a warning message pop up, just press the OK 
tab; we will cover this in the next lab.  In the table of 
contents, right click on the new data layer “Districts.shp” and 
click the option “Open Attribute table”. 

 
20.  Scroll down the table. There are 87 records (record one is 

numbered as 0 – see first observation in the table under 
column heading FID), one for each district in PNG. 
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21. There are multiple attributes, or fields. The “FID” field contains a unique identification 

number for every record. The “SHAPE” field describes the object geometry (Point, 
Line, Polygon).  Among other attributes is the District name (HRname), its 
corresponding District code (HRPcode). 

 
22.  The order in which the fields are displayed can be rearranged, much like in excel. 

Click once on the field name in order to highlight it, then, click a second time (you 
should see a white arrow), to drag it to your preferred location. Rearranging the data 
like this has no adverse effects on the database or map. 

 
23. Field data may also be sorted. Right Click on the field “HRname”. You will have 

option to sort “Ascending” or “Descending”. Depending on the field type, the data will 
be sorted in alphabetical or numerical order. Sort and resort this field and observe 
the effects on the table arrangement. 
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24. Records, as well as fields can be highlighted. When a record is highlighted in a table, 

its corresponding feature is highlighted in the map. A highlighted record or feature is 
said to be “Selected”. 

 
25. Right click on the field “HRname” and Sort Ascending. Click the grey tab at the left 

edge of the first record in the table, (Nuku). This record is now selected. See below. 

 
 
26. Move or minimize the attribute table in order to see the map more clearly. The Nuku 

district should be highlighted. You may have to use the “Zoom to Full Extent” to 
spot the selected district. 

 

 
 
27. To unselect this record, click the “Table Options” dropdown 

 on the top left-hand side of the attribute table, or and 

click “Clear Selection” OR click  tab. 
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28. You can also select objects in ArcMap directly from the map window. Close the 
attribute table for now. Pan to the South Eastern Area, and select a district using the 

following “selection” tool from the main toolbar.  
 
29. Reopen the attribute table for “District.shp”. On the bottom-center of the attribute 

table, click on the button “selected”. The district you selected should appear as the 
only records in this list.  

 
See how the link between table and map works; Items selected in the map are also 
selected in the table, and visa versa.  When you select a district, and you see that more 
is being highlighted than just the district, this is because the select tool selects the 
related area with each area file in the table of contents.   
 
So, not only did you select 
Abau district, but you also 
selected Central province.  
You can open the 
Province Attribute table 
and click on the “show 
selected records” tab, you 
will see that Central 
province is selected.  
30. To unselect this 

record, Select the 
“Clear Selection” tab 
on the top of attribute 
table, and click “Clear 
Selection”.(As shown 
below) 

 
Now unselect this record by selecting the “Clear Selection” tab on the top the Attribute 
table, and click “Clear Selection”. Close the attribute table.  If you still have an area that 

seems selected on your map, you can use the “Clear Selected Feature” button  to 
unselect everything in the Data Frame. 
 
Symbolizing Features 
Symbolizing features means assigning them colors, markers, sizes, widths, patterns, 
transparency and other properties by which they can be recognized on a map. Data 
Layers added to Arc Map have default Symbology. Points are displayed with small 
circles or diamonds, and polygons (or shapes) have a fill color and outlines. The colors 
for points, lines and polygons are randomly chosen. 
 
31. First, turn off the “Districts” layer, by clicking the little black check mark to the left of 

the layer name “Districts”. 
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32.  Then, use the “Zoom to Full Extent”  button to return to a view of entire PNG. In 
the Table of Contents, double-click on the color symbol for “Provinces” layer. The 

Symbol Selector dialog opens.   
 
33. The scroll box on the left contains predefined symbols. The options frame on the 

right allows you to pick specific colors and set outline widths. Choose a color of your 
preference for both Fill and outline. 

 
34.  Next, we will work on the 

Symbology for the Towns. In the 
table of contents, double click on 
the point symbol for the “Towns” 
layer. The Symbol Selector dialog 
opens once again. In the scrolling 
box of predefined point symbols, 
click “Circle 1”. In the “Options” 
frame, click the drop-down arrow to 
change the symbol size to 4 points. 
Again, choose your color 
preference. On the map, the Towns 
should display with your new 
symbol. 

 

35.  Choose a new color for the “River” 
layer also by double clicking on the 
line symbol underneath the layer in 
the Table of contents, as you did 
for the “Districts” and “Towns”.  

 
36.  Experiment with the colors and 

options for the various layers. You 
are not tied to those suggested by this lab. 

 
Labeling: All maps contain textual information. Features in ArcMap are identified with 
labels that make use of information from fields in the Attribute table to identify a 
particular set of features. 
 
37. For the moment, turn off your “Towns” and your “Rivers” layer. 
 
38. Double left click on the “Provinces” layer, The pop-up window you now see is called 

the “Layer Properties” dialog. The mapmaker controls many properties of an 
individual layer from this dialog, and we will work with this quite regularly in the 
future, but for the moment, click on the “Labels” tab and thick the “label features in 
the layer” (see below) 

 
39.  Click on the arrow for the drop down menu on the Label Field option, and choose 

“HRname” 
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41. Using the text tools, change the label to bold size 8. For more advanced options, 
Click on the button “Symbol”, then the button “Properties”, and finally the tab “Mask”. 
This will allow you to put a halo on your text. Choose a white halo, of 1.5 points.  
 
Click OK repeatedly to accept these changes and exit out of the Layer Properties dialog. 
You are encouraged to explore the other tabs within the labeling function at your leisure.  
For example, you can explore the “Label Styles” under Pre-defined Label Style to see 
different sizes of text and shadowing styles. 
 
Saving your Progress 
At this point, you have changed and customized quite a few features of this map. In 
order to preserve these changes, we will now save your progress as a “Project file”. 
A project file in ArcMap carries the file extension .mxd. An .mxd file saves each 
component of a working map, from the files you have opened, to the colors you have 
chosen. This allows you to edit and return to a particular map, repeatedly. 
 
42. From the “File” menu in the top left corner of your screen, choose “Save As”. 
Navigate to the GIS folder on the C: drive; C:/Student/GISLab/Lab01, and save as 
“Lab01_”Yourname”.mxd.  It is always a good idea to save your map repeatedly while 
working. 
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The Layout View 
43. You now have a basic GIS map of PNG. The next step is to prepare this map for 
printing. 
 
44. First, make sure that your “Provinces”, “Towns”, and “Rivers” shapefiles are all 
turned on by checking the checkmark box next to the layer name in the table of contents.   
 
45. The map window that you have been working in up to now is called the “Data View”. 
We will now move to a different map window called the “Layout View” to prepare the 
map for printing. The “Data View” is where you perform the majority of your GIS editing 
work, while the “Layout View” is where you arrange your map(s) along with preferred 
graphics for printing or export. To navigate between these two views, there are two small 
tabs located on the bottom left-hand corner of the main map window. 
 
46. The “Layout View” is represented by the sheet of paper map, and the “Data View” by 
the screen with map. Click over and back between these tabs, and observe the changes. 

 
47. The third little icon, 
represented by the double 
arrows, is the “Redraw/Refresh” 
button. Use this button at any 
time, if you feel your map has not 
redrawn fully after opening or 
editing. 
 
 
48. When you have finished 
experimenting with the alternative 
map views, select the layout view.  
 
49.  We want to select a paper 
setup that best fits the 
geographical nature of PNG in 
order to use the most space on 
our page for our map.  Click on 
the File tab in the upper left of 
your screen and scroll to “Page 
and Print Setup”.  Make sure you 
select Landscape for the 
Orientation.  Also click the 
checkmark to “Use Printer Paper 
Settings”.  This will give you a 
dotted outline of how far you are 
able to expand your map. (see 
next step) 
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50. Now, resize the window around your map of PNG, so that it fits within the printable 
area.  
 

  
51. Using the “Insert” menu, add a Title, Scale Bar, and North 
Arrow to your map. Using the insert title option, name your map 
“PNG: Provinces and Towns” (or something similar).  
 
There are many Scale Bars, and North Arrows styles to choose 
from. Pick your favorite. 
 
 
52. Return to the menu option “Insert” and click on “Legend”. 
 
53. In the Legend Wizard dialog that pops up, accept all the default 
options by Clicking 
“Next” repeatedly, and finally “Finish”. 
 
54. You will notice a small legend appear somewhere in the middle of your layout 
window. Position it correctly. 
 
55. If you wish to change the name of your layers in the legend, edit the corresponding 
text in the table of contents, and it will also change in the legend. Just click twice on the 
text in the table of contents to edit it, (as you would to rename a file in Windows 
Explorer). 
 

56. When you are happy with the appearance of your map, you can export this map as a 
.jpeg, by choosing the menu option “File”, scroll to “Export”, then save with as 
(Lab01_YOURNAME.jpeg) in your Lab01 folder following the instructions.  
 
PLEASE MAKE SURE: That you save the changes to your map before you 
continue. Your map should look similar to the one below (featuring your own color and 
style preferences of course). 
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Lab 02:  Advanced Symbology  
 
In the previous exercise, Rivers had the same line symbol regardless of their level of 
importance.  This is sufficient for a basic navigational map, but most GIS maps are used 
as a visual interpretation of tabular data, therefore we will learn how to visualize such 
data in this lab. 

1. Open a new, blank map by clicking on the “New Map” button  in the upper left 
corner of your screen below the “File” button. 
 
2. From your Lab01 folder, add the file “Province”, “Towns” and “Rivers”. Reorder these 
files in the table of contents so that “Towns” are on top, “Rivers” are next, then 
“Provinces” is at the bottom. Remember: Your table of contents must be in the Display 
mode, look at the bottom of the table of contents and make sure that the Display tab is 
selected. 
 
3. From your Lab02 folder, add the “Roads” shapefile.  Uncheck the roads layer for now 
so you don’t see it in your map frame; we will work on that later.  When you uncheck it, 
the roads layer should disappear from the Data Frame. 
 
4. Choose an appropriate color for the “Provinces” layer, and then SAVE your project file 
as Lab02_YOURNAME to the Lab02 folder. 
 
5. Double-click on the layer name “Towns”; this will take you directly to the “Layer 
Properties” for the layer. Select the tab “Symbology”. 
 
6. In the “Show” box (see graphic), click on the option “Quantities”, and the sub-option 
“Graduated symbols”. In the “Value Field” dropdown list, select the Field name 
“Pop”.   
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7. Click “Apply”, but not OK. If you move your dialog slightly you will see that the city 
symbols have changed. The map is still a little too busy. Change the “Symbol size” to 
“from: 4 to: 12”.  
 
Next, click on the “Classify” tab.  
This will take you to the 
“Classification” drop down menu 
(see graphic right). 
 
8.  Click on the arrow to the right 
of “Classes” and choose 2.  Click 
on the arrow to the right of 
“Method” and choose “Manual”. 
 
9. Choose your “Break Values” to 
be 50,000 and the second the 
same as it displays the maximum 
value of population of a town/city. 
(See right) 
 
10. Press OK once you have 
finished step 9. 
 
11.  Now you are back to the Layer Properties Window.  Double-click on the largest 
circle and chose a bright color to represent the cities that are greater than 50,000 
people.  Press OK.  Double-click on the other 
circle and chose the symbol “Circle 1” in the 
left box, change the size to 4 and choose a 
color for these cities that display population 
under 50,000.  
 
12. Press OK repeatedly until you see the 
mapping screen again. 
 
13. Now it should be clearer where the cities of 50,000 are.  Switch to your identify tool  

, click on one of the large circles.  Scroll up and down in the “Identify” window that 
appears in order to read the attribute information. What is the towns’ name (name)? 
What is its population (POP)?  What is the population (Pop)? 
 
Now, SAVE YOUR WORK again as Lab02_YOURNAME!! 
 
14. Okay, now we are ready to add our roads.  Check the box next to your roads layer 
so it appears in your Data Frame. 
 
15. The current display shows only road network, this is not very helpful.  Double click on 
the roads layer (double-click on the word ‘Roads’) in order to enter into the “Layer 
Properties” window.  Click on the Symbology tab like you did when you were working on 
the towns.  
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16. Click on “Unique Values” under the “Categories” option to the left of the Layer 
Properties window.  (see below) 
 
17. Next, in the drop down 
menu on the Value Field, 
choose “fc_categor” and then 
click on the tab “Add all 
Values”.   
 
18. Let’s first see how the 
Primary roads connect to major 
towns.   
 
19. Double click to the left of 
the “Primary” on the line 
symbol, this will take you to the 
“Symbol Selector” window, 
choose the “ExpressWay” 
symbol and press OK.  You are 
now back at the “Layer 
Properties” window. 
 
20. Now, press “Apply” and 
move the “Layer Properties” window to the side so you can see your map.  Now you are 
able to see the primary roads more clearly. 
 
21.  Now let’s label the other roads more clearly. Double click on the line next to the 
“Secondary” roads in order to the “Symbol Selector” again.  Choose “Major Roads” 
symbol and press okay.  Do the same for the roads labeled “Tertiary”, “Track” and 
“Unclassified” in order to display them in a different color.  Press Apply, and now all 
roads in your Data Frame should have the colors you chose to display. 
 
21. When you have finished experimenting with the alternative  
Roads views, select the layout view (see step 46 in previous 
exercise if you need help).  
 
22. Using the “Insert” menu, add a Title, Scale Bar, and North Arrow to your map.  
 
23. Return to the menu option “Insert” and click on “Legend”. 
 
24. In the Legend Wizard dialog that pops up, except all the default options by Clicking 
“Next” repeatedly, and finally “Finish”. 
 
25. You will notice a small legend appear somewhere in the middle of your layout 
window. Position it correctly. 
 
26. If you wish to change the name of your layers in the legend, edit the corresponding 
text in the table of contents, and it will also change in the legend. Just click twice slowly 
on the text in the table of contents to edit it, (as you would to rename a file in Windows 
Explorer). 
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27. When you are happy with the appearance of your map, you can export this map as a 
.jpeg, by choosing the menu option “File”, scroll to “Export”, then save following the 
instructions.  
 
Your map should look similar to the map below. 
 
 
PLEASE MAKE SURE: That you save the changes to your map before you continue. 
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Lab 03:  Chloropleth mapping in Arc-GIS 
 

1. Open a new, blank map by clicking on the “New Map” button  in the upper left 
corner of your screen below the “File” button. 
 
2. From your Labo01 folder, add the “Provinces” shapefile.  From your Lab02 folder, add 
the “Roads” shapefile.  From your 
Lab03 folder add the 
“LLG_pop_2000” shapefile.   
 
3.  Double click on your 
“LLG_pop_2000” layer in order to 
open up the “Layer Properties” 
window.  And choose the 
“Symbology” tab.  
 
4. Click on the “Graduated Colors” 
under the Quantities option on the 
left side of the Layer Properties 
window. 
 
5. Choose TOTPOP in the Value 
Field, which is the population count 
per LLG in 2000. 
 
6. Classify your data accordingly 
by clicking on the “Classify” button and choosing classifications for 
your values (see step 8 of the previous exercise for help in the 
specific steps of classifying your data). When finished, press 
Apply and Okay. 
 
7.  Now you are back to the Layer Properties Window.  Left click 
on the numbers under the label column.   Here you are able to 
change the labels of your data so when you make a map, the 
labels in the legend are clear (see above).  
 
8. Change all of your labels following the graphic above. Then click out of the labels box 
and press Apply and OK to return to the mapping screen. 
 
9. Make sure that your “Roads” layer is on and that you have classified your roads in 
hierarchical order. 
 
10. It is interesting to note spatially how population follows critical road infrastructure.  
But, is population count an appropriate measure to understand relationships between 
infrastructure and demography?  Let’s experiment with a different measurement to 
understand the differences and then create a map of both. 
 
11. Right click on the “LLG_pop_2000” layer name in the table of contents and press 
copy. 
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12. Scroll to the top of the Table of contents and right click on Layers tab  
and choose “Paste Layers”.  This will copy the same layer that you have already built on 
population count into the Table of Contents.  You will now have two of the same 
“LLG_pop_2000” layers in your table of contents. 
 
13. Now, double click on the new “LLG_pop_2000” layer that you just copied into your 
table of contents and Click on the “Graduated Colors” under the Quantities option on the 
left side of the Layer Properties window (as you did before in step 17 above). 
 
14. Choose DENSITY (this is the 
population density: average people 
per square kilometer by LLG). 
 
15. Classify your population density 
data by clicking on the “Classify” 
button and choosing classifications 
for your values.  See the picture to 
the right under the label “Range” 
which shows how the data 
classified. (look at step 6 above if 
you need help). When finished, 
press Apply and OK. 
  
16. Left click on the Symbol tab 
above the color squares and 
choose Properties for all Symbols. 
Under the Outline Color tab, choose 
No Color for your outline color and 
then press OK until you exit Layer 
Properties. 
 
17.  Notice how population density changes the further away one gets from the main 
infrastructure corridors. Turn off and on the “Roads” layer in order to see the Density 
differences under the “Roads” corridors. 
 
18. Now add your “Provinces” shapefile from your Lab01 folder.  Left click on the colored 
square underneath the layer in the table of contents in order to open the Symbol 
Selector window. Choose the “Hollow” option and press okay. 
 
19. Turn off the “Roads” layer and just look at the differences between Population 
Density and Population Count.  You can do this by turning off and on the Population 
Density “LLG” layer.  The layer beneath it is the Population Count layer. 
 
20. Looking at the Population Density map, we can see that parts of Hella, Southern 
Highlands, West Highlands, East Highlands, Egna,and Chimbu provinces have high 
population density (see two maps below).  In these high population density areas, what 
does the road infrastructure look like?  Are they well connected? 
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21. Now we will map both of the variables in the same layout window.  Switch to the 
layout view, by clicking on the layout symbol in the bottom left and corner of the map 

window.   
 
22.  Using the “Insert” menu, add a legend, and other appropriate cartographic elements 
to your map (North Arrow, and simple scale bar) for the Population Density map. 
 
Save your map if you haven’t recently!  
 
23.  In the layout window, resize the map, so that 
it is roughly half of the size of the page by clicking 
once on the map and then dragging one of the 
corner sizing squares to diminish the size of the 
map. (You will also have to resize the legend and 
other elements). Move them to the bottom right 
hand corner of your layout. 
 
24. From the “Insert” drop down menu, choose 
the “New Data Frame” option. This will add a new 
empty map window to your layout. (as seen in the 
figure-right) 
 
25. Now to add data to your new map window. In 
the table of contents, right-click on the 
“LLG_pop_2000” layer in your first Data Frame 
that you have been working with up until now and 
scroll to “Copy”. 
 
26. Now right-click on the “New Data Frame” 
listing and scroll to “Paste”. Repeat the process 
to add the “Provinces” layer to your second map 
window. 
 

Population Density Population Count 
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27. In a multi-map set-up such as this. Only one map may 
be considered “Active” at any given time. This means that 
you can only work on the elements of one map at a time. 
To “Activate” a map, you can simply click on it in the layout 
view, or, you can right-click on the title of its corresponding 
set of layers in the table of contents, and scroll to 
“Activate”.  
 

28. On switching to the “Data View” ,  you will 
notice that only the active map is shown.  
 
29. Test this by switching to the “Data View” and activating 
(from the table of contents) each map in turn. 
 
30. After understanding varying “Data View” interfaces, put the final touches on the 
maps (including adding another legend for the Population Count map) that you chose to 
make and export them as a .jpeg by going to the “File” button in the upper, left corner.  
Scroll to export and save as .jpeg in your Lab03 folder! 
 
Your layout window should now look something like this, but may have different colors! 
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Lab 04: Display Surveyed community locations on Google Earth 

1. Open a new, blank map by clicking on the “New Map” button  in the upper left 
corner of your screen below the “File” button. 
 

2. From your Lab01 folder, add the “Districts” shapefile.  
 

3. From your Lab04 folder, add the 
“Survey_community” shapefile.   

 
Prepare the layers and maps to be converted to KML 
by setting certain properties and data attributes that 
will ensure the KML created matches your 
requirements and is user-friendly and well-formed.  
 
4. Click on the rectangular symbol beneath 

‘Districts’   layer; this will take you 
directly to the “Symbol selector”.  

 
5. Change Fill Color of ‘Districts’ to Hollow and 

choose an appropriate outline width & color.  
 

6. Change the size and color of ‘Survey_community’ point layer as shown in the picture 
below 

 
  

7. Then SAVE your project file as Lab04_YOURNAME to the Lab04 folder. 
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Create the KML file 
There are two geoprocessing tools available for creating KML files from ArcGIS 
data: Layer To KML and Map to KML. Both tools create a KMZ (compressed KML) file in 
the output location.  

• Map To KML will export the entire map into. KML format. 

• Layer To KML will export only chosen layers to. KML format 
 
Map To KML 
The Map to KML tool allows multiple layers in an ArcMap map 
document data frame to be simultaneously exported to a KML file. 
Each layer will be maintained as a distinct folder in the KML, unless 
the option is used to convert all layers to a single flattened image. 

 
8. Create the KML file using one of the KML conversion tools: Layer 

To KML or Map to KML , click toolbox  from standard tool bar. 
 

9. In the ArcToolbox window, expand “Conversion Tools,” then “To 
KML,” and select “Map to KML.” 
 

10. When the “Map to KML” window appears, in the dialog box that 
appears, fill in the fields:   
• Map Document: use the browse button to find 

C:\Student\GISLab\Lab04\Lab04_YOURNAME.mxd  
 

• Data Frame should automatically set itself to Layers. 
 

• Output File: this is the name and place to which you will 
save your. KML file. Type in 
C:\Student\GISLab\Lab04\Lab04_survey_communities.kmz 
 

11. Click OK. The Map to KML 
progress indicator will appear in 
a new box. When the indicator 
says Completed, click the Close 
button. 
 
 
 

  

http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/layer-to-kml.htm
http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/map-to-kml.htm
http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/map-to-kml.htm
http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/layer-to-kml.htm
http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/layer-to-kml.htm
http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/map-to-kml.htm
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Open your .KMZ File in Google Earth 
 
12. Open Google Earth.  

 
13. Go to File→Open→ C:\Student\GISLab\Lab04 

14. Click and Open Lab04_survey_communities.kmz  
 

15. The map will be overlaid with your file and the globe will spin to PNG. Zoom in using 
the Zoom slider to magnify the map to the desired scale to see the individual/cluster 
of surveyed community locations. You can click on a community point to activate a 
popup box that will display the attribute information. 

  

 
 

Layer To KML 
The Layer To KML tool allows individual layers to be exported directly from ArcMap. You 
can control the appearance of KML in the properties of the layer being converted.  
 

1. If it is not open, first, open the .mxd file saved in Lab04 named after your name 
 

2. In the ArcToolbox window, expand “Conversion Tools,” then “To KML,” and select 
“Layer to KML.” 

http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/layer-to-kml.htm
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3. When the “Layer to KML” window 
appears, first select the shapefile 
‘Survey_community’ layer for the 
“Layer” box. 

 

4. Next select a directory (Lab04) for the 
file to be created and provide a name 
as “Lab04_YOURNAME_Survey” for 
the file. 

 

5. Click OK. 
 

 
 
 

6. Now, open Google Earth and from main menu click 
File>> Open…. 
 

7. Locate the KMZ file saved in Lab04 as 
“Lab04_YOURNAME_Survey.kmz”  

 
 

 
 
 
 
 
 
 

8. Since you have only converted the survey community locations, what displayed 
in the google earth is surveyed community locations. You can convert district 
layer and add to google earth.    
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Lab 05: Understanding Projections 
 
Projecting Map Data using ArcMap 
The location of any given place can be defined with reference to lines of latitude and 
longitude, which create an imaginary mesh over the world. Latitude and Longitude 
values belong to a spherical coordinate system – a system for defining locations and 
making measurements on a sphere, or something close to a sphere (a spheroid) like the 
earth. 
 

 
 
 
The latitude - longitude value of a point depends on the assumptions you make about 
the earth’s shape. The earth isn’t perfectly round. It bulges at the equator and is 
flattened at the poles. Technically, this makes it an oblate spheroid. 
 
Besides not being quite round to begin with, the surface of the earth has various bumps 
and indentations. Determining the exact shape of the earth is not a simple matter. 
 
There are many different models and ArcMap recognizes almost three hundred different 
projections. 
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To make one map, one of these models of the earth (or some part of it must be 
represented on a flat surface. This is accomplished by a mathematical transformation 
called a map projection. 
 

 
 
Just as location on a sphere is defined by latitude and longitude, location on a map is 
defined by Cartesian coordinates, which assign values to points according to their 
positions on a horizontal x-axis and a vertical y-axis. As opposed to a spherical 
coordinate system, this is known as a planar coordinate system. 
 
The exact location of a point on a map varies according to the map projection used. 
There are about 50 commonly used projections and many variations on each. 

 
Four world projections. Many projections are made for individual continents, countries, 
parts of countries, or strips of land that may cross international boundaries. 
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Every spatial data set in a GIS stores 
geographic coordinates for its features. 
These coordinates make up its geographic 
coordinate system (GCS). A data set that 
has been projected also stores Cartesian 
coordinates for its features. These make up 
its projected coordinate system. 
 
When you work with unprojected data (data 
that has only a geographic coordinate 
system), any measurements or calculations 
you make are only based on a sphere or 
spheroid. This is problematic because 
degrees of latitude do not have constant 
length. A degree of latitude at the 30th parallel 
(30 degrees north of the equator) is longer 
than a degree of latitude at the 60th parallel. 
Both represent 1/360th of a circle, but the 
circles have different circumferences.  
 

 
Since degrees of latitude are not constant, they can’t be used to make meaningful 
measurements of distance and area. This problem is overcome with map projections. 
On a flat surface, units of measurement (meters or feet, for example) are constant, 
which means that you can calculate meaningful area and distance measurements. 
There is another difficulty however. Since the world is a sphere, and maps are flat, you 
can’t go from one to the other without changing the proportions of features on the 
surface. Map projections distort shape, area, distance and direction. Some projections 
preserve one of these properties at the expense of others, some compromise on all of 
them, and some preserve properties for one part of the world and not the others. 
The Mercator projection, for example, preserves direction, but distorts area. The 
sinusoidal projection preserves area but distorts shape. 
 

 
In the Mercator projection, Greenland looks larger than Brazil, although Brazil is four times its 
size. Because direction is preserved, Brazil correctly appears due south of Greenland. In the 
sinusoidal projection, the proportional sizes of Greenland and Brazil are correct. Their shapes 
however are distorted – Greenland is too narrow, and Brazil is too wide. 
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Your choice of map projection allows you to control the type of distortion in a map for 
your area of interest. If you are working with a fairly small area and using an appropriate 
projection, the effects of distortion are insignificant. If you are working with the whole 
world, there is bound to be significant distortion of some spatial property. 
 
When you add a layer to a map, both its appearance, and, the results of measurements 
and calculations you make depend on its coordinate system. You can find a data set’s 
coordinate system in its spatial metadata. 
 
To access the metadata for your file (if indeed it exists) open ArcCatalog. ArcCatalog is 
a standalone application for managing geographic data. It is part of the ArcMap Suite, 
and is essentially an interactive browser for spatial information. 
 
To view the metadata for a particular file, double-click on the ArcCatalog icon on your 
desktop. In the table of contents, navigate to your chosen file. Highlight this file, and click 
on the Metadata tab that sits over the view window. (You can also access a preview of 
your spatial data by choosing the preview tab). 

 
 
 
When data sets that have the same coordinate system are added to a data frame, the 
features in each layer are correctly positioned with respect to each other. If you 
subsequently add a data set that has a different coordinate system, ArcMap changes it 
to match the others in a process called “on-the-fly” projection. This new, temporary 
projection is applied only within a particular data frame; the data set’s native coordinate 
system (the one shown in its spatial metadata) does not change. 
 
By default, layers are projected on the fly to the coordinate system of the first layer 
added to a data frame (even if the layer is later removed). The coordinate system is 
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stored as a property of the data frame and can be changed. You can project all layers in 
a data frame to any coordinate system ArcMap supports. 
 
To project a layer on the fly, ArcMap uses the information stored in its geographic 
coordinate system. On-the-fly projection works best when all layers in the map have the 
same GCS (in other words, when they all use the same model of the earth.) 
 
On-the-fly projections are less mathematically rigorous than permanent projections 
(which change the native coordinate system of the data set). If you plan to use data sets 
in an exacting analysis, you should project them permanently to the same coordinate 
system with the ArcToolbox Projection Wizard. 
 
 
Go to the next page for the Lab05 exercise. 
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Lab 05 - Part 1: Changing Data Projections in ArcMap 
 
1. Open ArcMap, and from your Lab05 folder, open the files, “World_Countries”, 
and “World30”. Change the Symbology of the “World30” layer so that it is a hollow fill, 
with black or grey outlines. 
 
2. Right click on “Layers” in the table of contents and point to “Properties”. Select 
the tab “Coordinate Systems” (if not already selected by default). 
 
3. Move the Properties window a little to the right so that the majority of your map is 
visible. 
 
4. You will see, under the box “Current coordinate system” that these shapefiles 
presently have a geographic coordinate system called “GCS_WGS_1984”. This 
stands for “Geographic Coordinate System (GCS), World Geodetic Survey 
(WGS), 1984” 
 
This is a popular projection for the World, and is the reference system used by GPS 
(Global Positioning System) Units. However, there are alternate projections available 
(such as those introduced in the intro, and they have different purposes for different 
maps). Let us explore them. 

 
5. In the folder tree, click on the folder (folders where all the alternate projections are 
stored). In the next list of folders, click on “Projected Coordinate systems”. The 
subsequent list is quite long, scroll to the end and click on “World”. 
These are the world level projections available in ArcMap. 
 

6. Select “Cylindrical Equal Area”, then click Apply, and OK. The appearance of your 
world map should change dramatically. (You may get a pop-up box asking you if you are 
sure that you want to do this, Just click OK). 
 
7. Move to the “Layout View” for your map. Resize your map so that it fits the whole 
page. 
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8. Return to “Layer Properties”, and click on the tab “Frame”. Remove the “Border” from 
around your map window. Then click OK. (This will make your final product a little less 
cluttered, as we plan to use several images). 
 
9. At this point, save your map in your Lab05 folder as “Lab_05World.mxd”. 
 
10. Next, go to the “File” dropdown menu. Choose “Export map”, and save your map, (as 
a .jpeg with resolution of 150), in your Lab05 folder as “C Equal Area”. 
 
11. Return to the table of contents. Once again, right-click on “Layers” and scroll to 
“Layer Properties”. Select the tab “Coordinate System” and following the same route as 
Step 5; (Projected…./World), select the projection “Equidistant Conic”. Click Apply, and 
OK. 
 
12. Look at how different this view of the world is! Once again, export this map as a .jpeg 
with resolution of 150dpi. Choose an appropriate name, e.g. “Equid Conic”.  
 
13. Using the instructions from the previous steps, produce 5 additional jpegs of the 
world using the following projections: 

a. Mercator 
b. Sinusoidal 
c. The World from Space 
d. Fuller 
e. Robinson 

 
14. Using Microsoft word, or PowerPoint, inserts the jpegs onto one page/slide. 
Label each projection according. See the next page for a sample layout of all images. 
 

15. Your finished product should look somewhat like the following graphic on the 
following page: 
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Lab 05 part 2: Bringing Field Data into the ArcGIS software 
program.  Allowing visualization using GPS point data. 
 
Assume a survey team has just returned from mission and gave you a simple database 
file containing the X, Y (latitudinal & longitudinal) information of survey community 
centers in certain districts of PNG.  This information must be visualized, and integrated 
into the spatial data repository. 
 
Close ArcGIS before you begin this exercise. 
 

1. Open Excel and go to your Lab 05 folder.  Open “community.xlsx”.  You can see 
that there is a “LONG” (longitude) and “LAT” (latitude) field, along with other 
information that describes community location. 
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2. You can directly bring an 
Excel worksheet into ArcGIS. 
Add the file “Districts” and the 
database file: 
“community.xlsx” and choose 
‘sheet1$’ from the from your 
Lab05 folder.  

 
 

3. Right click on the ‘sheet1$’ 
file and scroll to “Display XY 
data”.  Click on “Display XY 
data” and a window should 
pop up like the window to the 
right. 

 
4. Make sure that your “X Field” 

displays LONG for the 
coordinates, and your “Y 
Field” displays LAT for your 
coordinates.  Press OK 

 
5. You may get a warning message stating that 

your “Table Does Not Have Object-ID Field”.  
This is a unique identifier that ArcGIS builds 
into all of its shapefiles.  Press OK and ArcGIS 
will create this field for you. 

 
6. Now, can you see your “sheet1$ Events” 

points?  Where are they?  Right click on the 
“sheet1$ Events” layer, and from the menu 
choose “Zoom to layer”. The “sheet1$ Events” 
layer should now be visible, but not the 
“Districts” layer. 

 
7. Right click on the “Districts” layer and choose 

“Zoom to Layer”. What happens to the “sheet1$ 
Events” layer?  Magic, it disappeared…or is it 
a projection problem?? 

8. Go to the main tool bar, and select the “Zoom 

to full Extent” button  
 
9. You should now see the entire “Districts” layer, 

with one tiny dot to the South of the country.  If 

you use the regular zoom tool , and zoom 
repeatedly into this dot or draw a small square 
with your zoom tool, you will realize that it is in 
fact the “Community” layer.  As it is in a 
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different projection, it is unable to locate and resize 
itself correctly in relation to the “Districts” Layer. 

 
10. If we take the assumption that this information was 

collected by GPS, then reverting to the default 
coordinate system used by GPS will correct this 
issue. 

 
11. So let’s try our hypothesis!  First, Right click on the 

“sheet1$ Events” you select Remove. 
 
12.  Now, right click on the “healthcenters.csv” layer. 

Left click on the “Display XY Data”. 
 

13. As you can see, the coordinate system is 
unknown.  Click on the “Edit” button.  In the next 
window, click the “Select” button and choose the 
following path: 
    Geographic Coordinate Systems 
 World 
        WGS 1984 
 

14. Click Add. 
 
15.  Your “Add XY Data” window should now look like 

the graphic to the right. Click OK 
 

16. Now your community should be geographically 
contiguous with your “Districts” layer. 

 
17. Your “sheet1$ Events” is currently only a cosmetic 

layer.  We know this because it has the word 
“Events” following the name.  It is not yet a 
shapefile. 

 
18. To create a permanent shapefile from this cosmetic 

layer, right click on the “sheet1$ Events”, scroll 
down to “Data” and select the “Export Data” option. 

 
19. Leave all the initial options as default, but make 

sure to save the final file to Lab05 folder, calling the 
file “Community.shp” 

 
20.  A pop – up window will ask you if you would like to 

“Add to map”.  Select OK and the new shapefile 
should automatically add to the dataframe.  

 
21. Look at these data, where are community missing, why?  Add some other 

geographic data from your Lab01 – Lab04 folder (including roads) to see if you 
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can hypothesize.  Just looking at your map, can you tell the pattern of the 
community surveyed? 
 

22. Create a map with the community layer, and other key data. (hint: are they 
located along the road or river?) 
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Lab 06: Exporting external database information from ArcMap 
 
Exercise Overview 
Now you will perform what is known as a Spatial Join, links/combines the attributes of 
two layers, based on the location of each layer’s features. Just like a table join, a spatial 
join appends the attributes of one layer to another. You can then use the additional 
information to query your data in new ways. 
 
 
1. Open a new ArcMap session and add your new 

“health_facility” layer that you created in the previous 
exercise. 
 

2. Before you begin this exercise, you may need to add the 
spatial toolboxes to your data screen.  If the list of toolboxes 

(see left) is not on your screen click on the  button from 
the standard toolbar. 

 
3. Now, let’s make sure that your “health_facility” layer has a 

defined projection by going to the toolbox “Define projection” 
(see graphic Right).  

 
4. Define the projection in the “Select a Coordinate System” 

box, choose the following path: 
          Predefined 
               Geographic Coordinate Systems 

           World 
      WGS 1984 

 
 
5.  Press OK.  Now that we have 

defined all of our projections we 
can do a Spatial Join! 

 
6. Add your “Provinces” and 

“Districts” layer from your 
Lab01 folder. 

 
7. Right click on the “Districts” 

layer. Go to “Joins and Relates” 
> “Join” 

 
8. In the first drop down menu (see right), change the option to “Join data from another 

layer based on spatial location”. This choice will change the look of the wizard layout.  
 
9. Use the graphic to the right to select the correct options.  
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10. For Option 2: make sure the first radio button 
is selected (it should be by default), and that 
the “Sum” check box is ticked.   

 
11. Save the new file to your Lab06 folder, and 

call it “district_hfCt”.   
 
12. Click OK. 
 
13. The join process may takes few seconds, as 

ArcMap must count the number of health 
centers located in each district, and report 
that data in the attribute table of your new file 
“district_hfCt” 

 
As you can see, there are many other options 
within the Spatial Join tool. It can be used to 
determine how close an individual point or 
polygon is to another point or polygon in a 
different layer, and report its distance. You will 
use this function in a later exercise.  
 
14. “district_hfCt” should automatically add to 

your table of contents, if not, go to the “Add 
data” button, and from your Lab06 folder, 
add the new “district_hfCt” layer. For clear 
visibility, re-organize the layers. 

 
15. Open the attribute table of “district_hfCt” and 

scroll right until you see “Count_”.  
 
16. The field that you are interested in is the 

“Count_” field. Right-click on the field 
heading, and choose the “Sort by Descending” option. You will see that the 
maximum number of health centers for any one district is 75.  

 

 
 

17. Close the Attribute table for now, and let’s create a thematic map.   



 46 

 
18. Double click on the 

“district_hfCt” layer. This will 
take you to the “Layer 
Properties” dialog. Click on the 
“Symbology” tab.  In the “Show” 
menu to the left, Click on 
Quantities > Graduated colors. 

 
19. In the “Value field”, click the 

down arrow and scroll to 
“Count_”. 

 
20. In the “Color Ramp” field click 

on the down arrow and choose 
a color scheme that you like. 

 
21. Click OK when complete.  
 
22. Before you progress too far in 

your map production, let’s once 
again save your map as an 
ArcMap Document file (. mxd) so you won’t lose your work to date.  Go to “File/Save 
As”, navigate to your “Lab06” folder, and name the Project file: 
“Lab06_YOURNAME”. 

 
23. Now make sure that your “health_facility” shapefile is above your “district_hfCt” file in 

the table of contents so you are able to see both layers. 
 

24. Given that the districts are geographically larger than LLG, would it be better to look 
at statistics on a more disaggregated level.  You can do the same spatial join on your 
LLG layer to understand health facility placement at a finer level. 

 
 
Think about how you would aggregate similar data such as road data – you could do a 
spatial join, and average road lengths by district in order to arrive at a road density 
figure. 
 
Here is the difference between the province and district level statistics! 
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25. Now you will export this data to excel for graphing purposes.  
 
26. Open the “district_hfCt” attribute table again.  On the top left 

hand corner of the attribute table, click on the “Table options” 
button. From the menu, choose the “Export” option.  

27. Export your table as “district_hfCt” to your Lab06 folder. 
Although the file carries a .dbf extension, you will be able to 

open it in Excel, and save it to as regular  “.xlsx” file from which 

you will create your graphs. 
 
28. Go to Microsoft Excel, and from your Lab06 folder open the 

“district_hfCt.dbf” file. Note, you have to change the “Files of 
Type” dropdown to “All Files” in order to see those files with a 
.dbf extension (see below). 

 
 
29. Now you can save your table as an “.xlsx” file (excel) and graph 

it if you would like.   

District Level Province Level 
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Lab 07 – Data Integration and Thematic Mapping 
 
Exercise Overview 
You have received detailed Household Census information from the NSO of PNG. The 
data is in Microsoft Excel format, and you need to integrate this information into ArcMap 
to create a thematic map.   
 
To achieve this you must conduct a Table Join.  A table join appends attributes of a non-
spatial table, to the attributes of a map table. (Non-Spatial means “without geography”, 
i.e.: without map attached). In order for this join to be successful there must be a way to 
match records in one table with appropriate records in another. This is done with an 
attribute common to both, such as a name or ID code. 
 

Data Integration 
 
1. Open a new session of ArcMap.  From your Lab07 folder, add the layer 

“LLP_Pop05.shp”. 
 
2. Right click on the “LLP_Pop05.shp” file to open the “Attribute Table”. This table 

contains some basic demographic information, including population count and 
population density. 

 
3. Open Microsoft Excel. Go to File > Open > navigate to your Lab07 folder and 

open the file: “nso_census_2005.xlsx” 
 
4. You will see that this table has more population variables disaggregated by age 

group. 
 
 
5. If you intend to permanently save joined table to the shapefile make sure that the 

table is formatted correctly with only 11 characters for each variable name.   
 
6. Once you have formatted the excel file, save into your Lab07 folder, close excel and 

return back to ArcGIS. 
 
7. From Lab07 folder add the excel file “nso_census_2005.xlsx” and select 

‘nso_census_2005$’ sheet.  
 
8. Right-click on your “‘nso_census_2005$” table to open it. Make sure that all field 

names carried through correctly, and that all data appears in working order.  If it 
looks good, close the attribute table and move on! 

 
9. The next step is to join the “‘nso_census_2005$” table to the “LLP_Pop05” layer 

so that you can utilize its spatial properties to visualize the population info.  
 
It is always preferable to use codes, rather than place names to conduct joins.  Place 
names can vary in spelling and accent (which contribute to the unique nature of a 
particular name), and these may not always transfer from one software to another.  
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10. In this case, the joining variable is called 

“GEOCODE”. 
 
11. Right click on the “LLP_Pop05” layer, Scroll to “Join 

& Relates” > “Join”. Make the following dropdown 
selections, and click OK. 

 
12. When complete, open the attribute table of the 

“LLP_Pop05” layer to make sure the join was 
successful.  If you see fields that say <null>, in 
some cases it may be okay as data may not 
collected for the specific area BUT in some other 
cases the unique ID used to join may not match 
properly.   

 
13. Before continuing, save your map to your Lab07 

folder as “Lab07_YOURNAME”. 
 
14. Double click on “LLP_Pop05”.  The “Layer 

Properties” Window should now pop-up. If the tab 
“Symbology” is not selected, then select that tab. 

 
15. In the box labeled “Show”, select the option 

“Quantities”, and click on the sub-option “Graduated 
Colors”.   

 
16. In the drop down menu “Value:” scroll to the end of the list, and choose the field 

named “TOTPOP”: This stands for total population. 
 

**The variable labels follow a pattern, and are disaggregated by ages and gender.  
Note that each group of variables are labeled as such: 

• TOTMAL & TOTFEM: Male and female all ages respectively 

• POP_15TO19: Total population between 15 & 19 ages 

• MAL_15TO19: Male population between 15 & 19 ages 

• FEM_15TO19: Female population between 15 & 19 ages 

• POP_15TO49: Total population between 15 & 49 ages 

• MAL_15TO49: Male population between 15 & 49 ages 

• FEM_15TO49: Female population between 15 & 49 ages 
……. 

 
17. Once this field has been selected, choose a color ramp that you like by clicking on 

the down arrow next to the color ramp. Now click, Apply, and OK.   
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18. Look at how the colors 
are distribued. The 
classification brackets 
chosen by ArcMap are 
based on their default 
statistical classification; 
“Natural Breaks”. 

 
19. Reopen the “Layer 

Properties” dialog for the 
“LLP_Pop05” layer.  
Return to the symbology 
tab.  Under the 
Classification menu (top 
right-hand corner), Click 
the “Classify” button.  

 
 
 
 
 

20. In the “Classificaton Wizard” you will see a histogram illustrating the data 
distrubution along the number line.  

 
21. In the “Method” drop down list, you will see several classification alernatives to the 

“Natural Breaks” system. You also have the opportunity to change the number of 
classes that you use. (See graphic below) 

 
22. Experiment with the different classification schemes, and look at how they alter 

the classification breaks (blue lines) on the histogram data. By clicking OK on both 
wizards, you will see the effect of your class scheme changes on the map itself.  
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23. For something as simple as population count, “Natural breaks” is not a bad 
starting point. To make the interval ranges a little more “user friendly” it is 
advisable to begin with “Natural Breaks”, then switch to “Quantiles”, and modestly 
round up/down the break values of each category. 

 
24. Obviously, this decision will be determined by the nature of your data, and a 

classification method such as “Standard Deviation” may be more appropriate in 
certain cases. 

 
25. Return to the “Classification Wizard” screen. Choose first the 

“Quantiles” scheme, next change the number of classes to 7.  
 

26. In the “Break Values” box to the right-hand side of the wizard, set the 
break values to the following numbers, by simply typing over the 
existing values.  

 
27. When done, click OK. Now you are back at the “Symbology” window.  

The “Label” side of the menu will reflect the changes that you make to 
the “Range” side, but you may also use text in your labels.   
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28. Now return back to your 

“LLP_Pop05” layer with the 
table join.  Double click on the 
layer and return to the 
Symbology tab.  

 
29. Modify the label options with 

some additional text, and 
commas by clicking on the 
value under the Label column. 
(This will determine the look of 
your legend, and reads better 
than the default categories).  

 
30. For a softer subtler style, you 

will remove the boundaries 
from between the individual 
LLP. Click on the word 
“Symbol” above the colored 
category symbols, and in the 
pop-up menu, choose “Properties for all 
symbols”.  (see right)  

 
31. In the “Symbol Selector” dialog, change the 

outline color to “No color”. 
 

32. Click OK. 
 

33. To distinguish the boundaries of the higher 
order administrative units, add the 
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“Provinces” layer from the Lab01 folder, and symbolize as hollow with an 
appropriate outline thickness.  Remember how to do this?  (hint: double click on 
colored box symbol below the layer name in the Table of Contents) 

 
34. Switch to the layout view, by clicking on the layout symbol in the bottom left and 

corner of the map window.   
 

35. Using the “Insert” menu, add a legend, and 
other appropriate cartographic elements to 
your map (North Arrow, and simple scale 
bar) 

 
36. Save your map if you haven’t recently!  

 
37. In the layout window, resize the map, so that 

it is roughly one-half the size of the page by 
clicking once on the map and then dragging 
one of the corner sizing squares to diminish 
the size of the map. (You will also have to 
resize the legend and other elements). Move 
them to the top right hand corner of your 
layout. 

 
38. From the “Insert” drop down menu, choose 

the “New Data Frame” option. This will add a 
new empty map window to your layout. (see 
below) 

 
39. Now to add data to your new map window. In 

the table of contents, right-click on the “LLP_Pop05” layer in your first Data Frame 
that you have been working with up until now and scroll to “Copy”. 

 
40. Now right-click on the “New Data Frame” listing and 

scroll to “Paste”. Repeat the process to add the 
“Provinces” layer to your second map window. 

 
41. Right now, each window looks identical. To help 

distinguish between the windows, double click on 
the “LLP_Pop05” layer for your new map (leave the 
first map as is) and return to the “Symbology” tab of 
“Layer Properties”. In the “Show” box click once on 
the word “Quantities”, and then “Graduated Colors”. In your “Value” drop down list, 
choose any of the variables you are interested in the drop down list.  You can 
choose a specific age group, or if you want, to aggregate population at a specific 
age group, you can add a field and sum columns.  I chose “POP_15TO49” to map 
“total population of ages between 19 &49”, but it may be interesting to look at 
male versus female population. 

 
42. Once you have chosen your variable, press OK to map that variable and see how 

it looks spatially across the LLP of PNG.  How does it vary from your other map? 
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43. In a multi-map set-up such as this. Only one map 

may be considered “Active” at any given time. This 
means that you can only work on the elements of one 
map at a time. To “Activate” a map, you can simply 
click on it in the layout view, or, you can right-click on 
the title of its corresponding set of layers in the table 
of contents, and scroll to “Activate”.  

 

44. On switching to the “Data View” , you will notice 
that only the active map is shown.  

 
45. Test this by switching to the “Data View” and 

activating (from the table of contents) each map in 
turn. 

 
46. After understanding varying “Data View” interfaces, put the final touches on the 

maps that you chose to make and export them as a .jpeg by going to the “File” 
button in the upper, left corner.  Scroll to export and save as .jpeg in your Lab07 
folder! 

 
Your layout window should now look something like this (of course yours may be 
mapping different variables):  
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Lab 08 – Agricultural system mapping 
 
Exercise Overview 
For this exercise partial spatial database of the Papua New Guinea Agricultural System 
project, comprises variety of data on agricultural crops and practices on small holder 
(subsistence) farmers, provided to create maps of dominant staple crops and sub 
dominant staple crops. 
  
From the six types of agricultural system categories (Fallow system, fallow period, 
cultivation intensity, staple crops, garden and crop segregation and soil fertility), this 
exercise focuses on mapping the distribution and pattern of staple crops in PNG.  To 
achieve this, you will be joining the spatial data and table that describes the coded value 
in the database.   
 

Data Integration 
 
1. Open a new session of ArcMap.  From your Lab08 folder, add the layer 

“dist_agrisys.shp”. 
 

2. Right click on the “dist_agrisys.shp” file to open the “Attribute Table”. This table 
contains agricultural system variables and values. 

 
3. Open Microsoft Excel. Go to File > Open > navigate to your Lab08 folder and open 

the file: “Domstap_legend_desc.xlsx” 
 

4. You will see that this table has DOMSTAP codes and descriptions 
 

5. If you would like to keep this legend description permanently saved in to the 
shapefile along the code, make sure to format the table with only 11 characters for 
legend description field.   

 
6. Once you have formatted the excel file save into your Lab08 folder, close excel and 

return back to ArcGIS. 
 

7. From Lab08 folder add the excel file “Domstap_legend_desc.xlsx”” and select 
‘Domstap_legend_desc$’ sheet.  

 
8. Right-click on your “Domstap_legend_desc$” table to open it. Make sure that the 

legend description field name carried through correctly, and that all data appears in 
working order.  If it looks good, close the attribute table and move on! 

 
9. The next step is to join the “Domstap_legend_desc$” table to the “dist_agrisys” layer 

so that you can utilize its spatial properties to visualize the population info.  
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10. In this case, the joining variable 
is called “DOMSTAP”. 

 
11. Right click on the “dist_agrisys” 

layer, scroll to “Join & Relates” 
> “Join”. Make the selections as 
seen in the picture (right) and 
click OK. 

 
12. When complete, open the 

attribute table of the 
“dist_agrisys” layer to make 
sure the join was successful.  If 
you see fields that say <null>, 
in some cases it may be okay 
as data may not collected for 
the specific area; BUT in some 
other cases the unique ID used 
to join may not match properly.   

 
13. Before continuing, save your 

map to your Lab08 folder as 
“Lab08_YOURNAME”. 
 

14. Double click on “dist_agrisys”.  
The “Layer Properties” Window 
should now pop-up. If the tab 
“Symbology” is not selected, 
then select that tab. 
 

15. In the box labeled “Show”, 
select the option “Categories”, 
and click on the sub-option 
“Unique values”.   
 

16. In the drop down menu “Value:” 
scroll to the end of the list, and 
choose the field named “DOMSTAP_desc”: This stands for dominant staple crops 
description. 

 
The Dominant Staple Crops [DOMSTAP]: defined as the most important staple food 
crops grown in the subsystem. A major staple is defined as a crop estimated to cover 
more than one-third of staple garden area, and therefore no more than 3 dominant 
staples may be identified for a system. An important exception occurs when sago is the 
staple. Sago is extracted from palms which are not cultivated in gardens. In the text 
accounts (System Summaries and Notes), dominant staples are described as the 'most 
important crops'. 
 
17. Once this field has been selected, choose a color ramp that you like by clicking on 

the down arrow next to the color ramp. Now click, Apply, and OK.   
 



 58 

 
 
18. Look at how the colors 

are distribued. The 
unique classification 
reveals types of 
dominant staple crop 
types. 

If you would like to use a 
readymade classification 
layer  
 
19. Reopen the “Layer 

Properties” dialog for 
the “dist_agrisys” 
layer.  Return to the 
symbology tab.  Under 
‘Draw categories 
using unique values of 
one field” (top right-
hand), Click the “import” button.  

 
 
 

 
 

20. In the Import Symbology” click open  
folder symbol to import readymade legend 
stored in Lab08. Select 
‘AgSystem_lengend.lyr” and click add.  

21. In the ‘Import Symbology Matching Dialog’ 
make sure the value field being used to 
match the layer is “DOMSATP_desc” and 
click OK.  
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22. You will have a classification as dipcited in the picture above. Next, create a map 

following the steps completed in the earlier labs and come up a map similar to the 
map below. 



 60 

 
 

 
Now create dominant staple crop maps of survey districts and overlay surveyed 
community locaiton. 
23.  From Lab08 add “survey_community” gps data. 
24. To locate survey districts, from Lab01 add districts and in the table of contents click 

on a rectangular box right beneath Districts layer  which opens up 
‘symbol selector’ dialog box and choose the boundary hollow. 

25. From the “Insert” drop down menu, choose the “New Data Frame” option. This will 
add a new empty map window to your layout. (as seen in the figure-below) 
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26.  Add province data to your new map window. In the table of contents, right-click on 

the “Provinces” layer in your first Data Frame that you have been working with up 
until now and scroll to “Copy”. 

 
27. Now right-click on the “New Data Frame” listing and scroll to “Paste”.  

 
28. Resize and locate at the top-right corner of the map so that it fits within the printable 

area. 
 

29. Now, let’s select districts where the survey undertaken. Doboule click on ‘districts’ 
layer and click ‘Definition Duery’ tab.  
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The survey conducted in Sandaun, East Sepik, Madang and Bougainville provinces 
mainly in and around Nuku, Maprik, Middle Ramu and South Bougainville districts. 
So to create large scale mapping that display a specific survey site select districts 
where surveyed communities located. For this particular example, select zoom to 
“Nuku” distrtrict and see the distribution of survey communities against agricultural 
system map. 

30. While ‘Definition Query’ tab 
selected on Layer properties 
window click “Query Builder”. From 
the variables listed in “Query 
Builder’ scroll to ‘HRname’ and 
double click it. That throws it to 
“SELECT *FROM Districtis 
WHERE” query window.  

31.  From the list of logical operators 

double click . 
32. Click on ‘Get Unique Values’ tab 

and type ‘nuku’. The actual ‘Nuku’ 
value will show up in the value list 
of HRname field. Double click 
‘Nuku’ from the list. 
To verify if your syntax is valid, click 
verify. 
 

 
 

 

 

33. If your query is successful, at this point only ‘Nuku’ district 
boundary is visible. Now, right click ‘districts’ layer from the 
table of content click zoom to layer 

 

 

34. You can see communities surveyed in Nuku district. For final 
map creation change the 
inset map and legend 
properties. 

 

 

35. To change the inset map properties, right 
click the inset map and point to 
Properties. 
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36. Select “Frame” tab and click the drop down under ‘Background’ and select 
‘white’ and click Apply. 

 
 
 
 

37. While in ‘Data Frame Properties’ click 
‘Extent Indicator’ tab. Select ‘Layers’ from 

‘Other data frames’ and click and 
Apply.(see picture-right) 
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38. Next, let’s change legend properties so that it only shows classes that are 
visible in the current map extent. Double click legend from the map to get 
‘legend Properties’ window.  Click ‘Items’ tab and select ‘dist_agrisys’ layer. 
From ‘Map Extent Option’ tick the square box next to “Only show classes that 
are visible in the current map extent’ and click apply. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
39. Save your map if you haven’t recently!  

 
40. Your layout window should now look something like this (of course yours may 

look different):  
 

41. Put the final touches on the maps that you chose to make and export them as 
a .jpeg by going to the “File” button in the upper, left corner.  Scroll to export 
and save as .jpeg in your Lab08 folder! 
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